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Assignment 8: About Storage Devices
If the computer could not store data, each time you turned the computer off, you would
lose everything. You would not be able to install any programs or save your work.
The computer uses different storage devices to store data. Read the information to learn
about floppy disks, CDs, DVDs, flash drives, and hard disks.
In the next assignment, you will add slides to the information package that explains
storage devices to customers.
Storage Mediums
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Over the years, the technology used to store information has changed dramatically. The storage
mediums used today are faster, have a larger capacity, are more durable, and in many cases
are more portable, than those used in the past.
Each storage medium has a surface that stores information. This surface is divided into small
sections that are used to store data. The reason a storage medium is divided into sections is so
the computer knows where to look for the information stored on the disk.

sector

tracks

A disk is divided into sectors that are shaped like wedges.
Data is stored in each sector.
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There are different types of storage mediums used to store data. Often the type used depends
on the purpose. For example, there are floppy disks, CDs, DVDs, flash memory, and the hard disk.
Floppy disk
Many years ago, a floppy disk was used for data storage. A floppy disk is a
removable disk that stores information magnetically using a floppy disk drive. The
floppy disk used to store up to 1.44 MB of information. Since this is not very much,
the floppy disk is now rarely used by people. In fact, most computers today do
not contain a floppy drive. Despite not being used anymore, the floppy disk
remains the symbol used in most programs for the Save tool.
1.

Does your computer have a floppy disk drive?

2.

Do you use a floppy disk drive to store information? Why or why not?
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CD and DVD
is a short form for compact disc and DVD is a short form for digital versatile disc.
Both are round storage devices that are about 4.75 inches (12 cm) in diameter.
They are commonly used to store software programs, music files, and movies. As
well, they can be used to save a back up of important data files.
CD

How is information read and written to a CD?
Data on a CD or DVD is read and written using an optical drive. Once a CD or DVD is inserted into
an optical drive, a motor starts to spin the disc. A laser scans the surface looking for changes in
light. It is the lightness or darkness of the surface that tells the computer about the data that is
stored on the disc.
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Both a CD and DVD are made out of plastic. Information is added or written to the disc with a
laser that heats the surface. This is why creating a disc is called burning. Information is stored in a
track that is in the shape of a spiral. The track goes from the center of the disc to the outer edge.
Is burner speed important?
CD and DVD optical drives are rated based on burning speed. The burning speed is how many
times faster the drive spins the CD or DVD when burning data to the storage medium than when it
is just reading a CD or DVD. Reading a CD or DVD is 1x. Therefore, a burning speed of 16x means
that the optical drive is spinning the CD or DVD 16 times faster than normal. A faster burning
speed is preferred. However, to avoid errors, it is often a good idea to burn a CD or DVD at a
speed slower than the maximum rate.

Why does a DVD hold more data than a CD?
Although a CD and DVD look the same, each device can hold different amounts of data. For
example, a CD can hold 650 MB of data, whereas a DVD can store 4 GB. Data on a CD or DVD is
stored in tracks. In the case of a DVD, the tracks are thinner than on a CD, which means more
information can be burned onto the same size surface.

There are several types of CDs and DVDs. Some CDs and DVDs are designed so that you can look
at the information on the disc, but you cannot edit, add, or delete files. Others are designed so
you can add data but afterwards the data is permanent and cannot be edited or deleted. Still
others can add, edit, and delete files repeatedly.
CD-ROM

and DVD-ROM: ROM stands for read only memory. Information on the disc is
permanent and cannot be added, edited, or deleted. This method of data storage is
used for software, audio CDs purchased from a store, or a movie that you rent.

CD-R and DVD-R: R that stands for recordable. Information on the disc can be added, but
once on the disc it is permanent. This type of disc is good if you want to burn data and
then never change the content. For example, if you were making a custom music CD,
video of a family trip, or back up of important data files you would use a CD-R or DVD-R.
CD-RW and DVD-RW: RW stands for recordable and writeable. These discs can have files
added, edited, and deleted from the disc over and over again.

3.

What advantage is there to using a DVD to store data in comparison to a CD?
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Why are there different types of CDs and DVDs?
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Flash Memory
Flash memory is a computer chip that is used to store information. Flash memory is
commonly used in cameras, fax machines, and other electronic devices to save photos,
music, user settings, or other data. Flash memory chips are also used in a storage device
called a flash drive or USB drive. A flash drive is a small device the size of a thumb.
A flash drive contains a flash memory chip that is used to store data. The flash memory chip is
protected by a small plastic case. The plastic case has a USB slot at the top that is used to plug
the flash drive into the USB port on a computer. Information can then easily be read or written to
the flash drive. Since the device is plugged into the USB slot, it is sometimes called a USB drive.
Storing data happens in a flash! Data on a flash drive is added or erased with electronic pulses.
Flash memory has a grid of columns and rows that divide the surface into blocks that can be
erased or written to without affecting the other areas. Flash memory offers a quick method of
data storage, because the information is erased one block at a time, instead of one byte at a
time.
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4.

Why do you think the device is called a flash drive?

5.

Do you have a flash drive? If yes, what files do you store?

6.

List three reasons why flash memory is a popular storage medium.
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The use of the flash drive continues to grow in popularity. This is likely because it is an affordable
portable device that can hold lots of information. You can purchase a flash drive that holds
1GB, 2 GB, 4 GB, 8 GB, 16 GB, 32 GB or more! It is easy to see why more and more people are
using it to store files instead of using a CD or DVD.

A flash drive can be
called a thumb drive,
USB drive, or flash drive.
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Hard Disks
A hard disk or hard drive is a storage medium used to store programs, user
settings, and files. Hard disks were invented in the 1950s. They started as
large disks up to 20 inches in diameter holding just a few megabytes. Today,
they are the size of your hand and can hold one terabyte of data.
Nearly every desktop computer and server in use today contains one or more hard disks. Every
mainframe and supercomputer is normally connected to hundreds of them. The hard disk is used
to store digital information in a relatively permanent form. They give computers the ability to
remember things when the power goes out.
Hard disks have an aluminum or glass disk that is layered with a magnetic recording material.
Information is read and written to the disk using read/write heads.
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How does a hard drive work?
When the computer requests information the circuit board inside the hard drive box, tells a
motor to spin, which causes the hard disk or platter to turn. A mechanism moves an arm that
holds the read/write heads. The arm moves quickly from the center of the disk called the hub to
the outer edge of the platter to locate the information in the proper sector. Once the
information is found, the read/write heads send the information to the circuit board, which then
relays it to the computer, or more specifically, the CPU. This all happens without the read/write
heads ever touching the platter. Instead, they rest directly over the platter.
Hard disks have dramatically increased their storage capacity over the years, although the
overall design has changed very little. How is this possible?

Year: 2006

Year: 1992

500 GB

6 GB

There are three ways to measure the performance of a hard disk:



7.

Storage Capacity: amount of bytes of data the hard disk can store
Data Rate: number of bytes per second that the drive can deliver to the CPU
Seek Time: amount of time it takes between the time that the CPU requests a file and the
first byte of the file starts being sent to the CPU
Why does a computer need a hard drive?
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The difference between hard disks from the past and today are the size of the heads. Since the
heads are made tinier, it is possible to divide the platter into smaller sectors. The more sectors,
the more data storage.
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Assignment 9: Information Package and Storage Devices
You are going to create a set of slides in the information
package that explains to customers about storage devices. For
each device, you will explain the purpose, offer
recommendations about purchasing, and include a picture.

Open Information Package in Microsoft PowerPoint
 Open Microsoft PowerPoint.
 Click the Office Button and select Open.
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 Go to the place where you saved your work. Select the company name file and then
click Open.

View Slide 2
 To move to Slide 2 press the PAGE DOWN key on the keyboard
or click Slide 2 in the Outline pane.

Create a Slide Explaining the Purpose of Storage Devices
 On the Home tab, click the New Slide arrow.
 Select Title and Content from the gallery.
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 In the Click to add title placeholder, type About Storage Devices.
 In the Click to add text placeholder, answer the question, "Why does a computer need
storage devices?". Press ENTER.
 Type There are several types of storage devices including: Press ENTER.
 Press TAB to indent the bullets. Create a list of storage devices:
o

Floppy Disk Drive

o

Optical Drive

o

Flash Drive

o

Hard Drive
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Create Slides About Types of Storage Devices
 On the Home tab, click the New Slide arrow.
 Select Two Content from the gallery.
 In the Click to add title placeholder, type Floppy Disk Drive.
 In one of the content boxes, answer the following questions:
o

What is the purpose of a floppy disk drive?

o

Why is the floppy disk drive rarely used today?

o

Most computers no longer come with a floppy disk drive. When would it be
necessary to include a floppy disk drive?
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 In the second content box, click Clip Art.

 Type floppy disk in the search box and then click Go.
 Click on a clip art in the pane to add it to the slide.
 Make a slide for each storage device. Include
a clip art of each device on the slide.
Optical Drive

You can use your skills to
format the clip art. Double
click on the clip art. Use
the commands on the
Picture Tools tab.

o

What is the purpose of an optical drive?

o

What should a person look for when selecting an optical drive?

o

What is a flash drive?

o

Why are flash drives popular?
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Flash Drive

Hard Drive
o

What is the purpose of a hard drive?

o

What should a person look for when selecting a hard drive?

You need to write about each storage device using descriptions that people
who do not know a lot about the computer will understand.

Save Changes to the Information Package and Exit Microsoft PowerPoint
 Click Save on the Quick Access Toolbar.
 Click the Close button.
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Assignment 10: Comparison of Storage Devices

Follow the instructions to compare the storage capacity of a CD, DVD,
flash drive, and hard disk.
In the following assignment, you will add this information to the
Information Package using a table.
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Storage Capacity of a CD
 Insert a CD that has content into the optical drive.
 Click Start. Click Computer.
 Right click on the optical drive. Click Properties.
– The amount of used and free space will be listed.

1.

A CD-ROM will have no free
space because it cannot have
data added to the device.
However, a CD-RW will have
free space because data can
be added, deleted, and
changed.

A CD can hold 650 MB.
How much space is used on the CD?

Storage Capacity of a DVD
© 2010 B.E. PUBLISHING, INC. ALL RIGHTS RESERVED.

 Insert a DVD that has content into the optical drive.
 Click Start. Click Computer.
 Right click on the optical drive. Click Properties.
– The amount of used and free space will be listed.

2.

A DVD can hold 4 GB.
How much space is used on the DVD?
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Storage Capacity of a Flash Drive
 Insert a flash drive into a USB slot on the computer.
 Click Start. Click Computer.
 Right click on the optical drive. Click Properties.
– The amount of used and free space will be listed.

3.

Storage Devices | Session 2

NAME

A flash drive can hold 1 GB, 2 GB, 4 GB, 8 GB, 16 GB, 32 GB, or more!
What is the capacity of the flash drive?
How much space is used on the flash drive?
How much space is free on the flash drive?

Storage Capacity of a Hard Disk
 Click Start. Click Computer.
 Right click on the C: drive. Click Properties.

4.
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– The amount of used and free space will be listed.

A hard disk can hold 250 GB, 500 GB, 1 TB, or more!
What is the capacity of the hard disk?
How much space is used on the hard disk?
How much space is free on the hard disk?
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Assignment 11: Information Package and Comparison Chart
You will create a table that compares the storage capacity of a floppy disk,
CD, DVD, flash drive, and hard drive.
Open Information Package in Microsoft PowerPoint
 Open Microsoft PowerPoint.
 Click the File tab and select Open.
 Go to the place where you saved your work. Select the company name file and then
click Open.
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View the Last Slide
 To move to the last slide use the PAGE DOWN key on the keyboard
or click the last slide in the Outline pane.
Insert a Table for the Comparison Chart
You will insert a table onto the slide. It will have two columns and six rows.
 On the Home tab, click the New Slide arrow.
 Select Title and Content from the gallery.
 In the Click to add title placeholder type Comparison of Storage Capacity.
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 Click Insert Table on the placeholder.

 Type in the number of columns and rows for the table.
2 columns
6 rows

 Click OK.

Look for the Table Tools contextual tabs that show up on the ribbon. There are two
contextual tabs– the Design and Layout tabs.
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Apply a Style to the Table
You can change the style of the table. Pick a style from the gallery.
Pick a Style
 On the Table Tools Design tab find the Table Styles group.
 Click the More arrow to see more designs.

 Click on a style you like.

More
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Change the Shading, Borderlines, and Effects
You can customize the table by changing the shading color, borderlines, and effects.
 Select the table.
 Click inside a cell or click and drag the mouse to select a row or column.
 On the Table Tools Design tab, find the Table Styles group. Try the following commands to
change the way the table looks. After using each command, put a checkmark in the
box. 


Fill a cell with a color, gradient, texture, or picture.



Apply borderlines to each cell.



Add an effect to the table such as a cell bevel, shadow, or reflection.
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 Use your skills to format the table.
You can edit the borderline color, line style, and
width using the commands in the Draw Borders
group on the Table Tools Design tab.
To exit Draw Borders, click Draw Table.
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Resize the Table
You need to resize the table to make if fill the slide. When you resize the table, the height of
each cell is adjusted, to make each the same height.
 Place the mouse pointer over the bottom sizing handle.
 Click and drag downwards to make the table larger.
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Add Table Headings to the Top Row
You need to add the headings Storage Device and Storage Capacity to the top row of the
table. You will then change the alignment of the cells to make the headings look great.
 Click inside the top left cell. Type Storage Device.
 Press TAB. Type Storage Capacity.
 Place the mouse pointer beside the top row. When the mouse pointer changes to a
black arrow, click the mouse to select the row.



Align the words to the left side of the cell.



Align the words in between the left and right side of the cell.



Align the words to the right side of the cell.



Align the words to the top of the cell.



Align the words in between the top and bottom of the cell.



Align the words to the bottom of the cell.
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 Click the Table Tools Layout tab, find the Alignment group. Try each command to
change the alignment of the words in the cell. After using the command put a
checkmark in the box. 

 Use your skills to align the words in the cells.
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Add Information About the Storage Devices to the Table
You need to add the storage devices to the table.
 In the LEFT column under the Storage Device heading add:
o

Floppy Disk

o

CD

o

DVD

o

Flash Drive

o

Hard Drive

 In the RIGHT column under the Storage Capacity heading, add the amount of
information stored by each device.
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 Use your skills to change the alignment of the words in the cells.

You can resize the width of columns.
Place the mouse pointer over the
center borderline. When it changes to
a two-way arrow, click and drag to the
left or right.

Complete the Storage Device Comparison Slide
 Use your skills to finish the slide. Complete the checklist:
 Does the slide title say Comparison of Storage Capacity?
 Does the table have headings that are easy to read?
 Does the slide have a list of storage devices?
 Is the storage capacity for each storage device accurate?
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 Does the table have a style that makes the information easy to read?
 Is the information aligned in the table cells?

Save Changes to the Information Package and Exit Microsoft PowerPoint
 Click Save on the Quick Access Toolbar.
 Click the Close button.
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Session 2 Review: Data Storage
What storage medium is right for the job?


DVD



flash drive



CD

1.

Kyle works for a company that needs to create a back up of important files. They need to
back up 3.5 GB of data. What storage medium is right for the job? Why?

2.

Cheryl is working on the school year book. She needs to share the photos and articles with a
friend. There are many files and they take 8 GB of storage space. What storage medium is
right for the job? Why?

3.

Alex wants to install a program. Where should he store the program on his computer? Why?
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/6

4. MB

a. A language used by the computer that uses 1‟s or 0‟s.

5. Sectors

b. The smallest unit of data a computer can understand.

6. Bit

c. Eight bits.

7. Binary Code

d. Short form for megabyte.

8. Byte

e. A location where data is stored on a disk.
/5
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Match each term with the correct description.

